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ВВЕДЕНИЕ 
 

Важными навыками, которые должны быть приобретены выпуск-

никами факультета физики и информационных технологий, можно счи-

тать следующие: анализ физических закономерностей на основе совре-

менных теоретических представлений и использование математических 

и компьютерных методов; выполнение исследовательской работы в об-

ластях, где используются физико-математические методы анализа и 

компьютерные технологии; разработка физико-математических мето-

дов для решения задач в областях техники, экономики и управления; 

производство расчетов при проектировании стандартных конструкций 

и компонентов электронных систем безопасности с учетом знаний в об-

ласти механики материалов и теории машин и механизмов. 

Формирование этих навыков тесно связано с использованием ком-

пьютерного моделирования для изучения разнообразных физических 

процессов, происходящих в материалах и изделиях. 

В настоящее время ведущие компании мира используют про-

граммное обеспечение ANSYS при создании своих наукоемких изде-

лий. ANSYS используется на таких известных предприятиях, как BMW, 

Boeing, БелАЗ и др. При этом происходит сокращение сроков, сниже-

ния себестоимости и повышения качества выпускаемых изделий, 

уменьшение количества рекламаций и материалоѐмкости, сокращение 

количества натурных испытаний. ANSYS предлагает рабочую среду с 

полным набором инструментов для анализа: от подготовки геометрии 

до подключения дополнительных физических компонентов для еще 

большей точности расчетов. Интуитивно понятный и настраиваемый 

пользовательский интерфейс позволяет инженерам любого уровня под-

готовки быстро получать ответы и решать производственные задачи. 

В практическом руководстве рассмотрены основные сведения о 

комплексе ANSYS MECHANICAL APDL, представлены основные эта-

пы анализа задач в нем при помощи графического интерфейса, приве-

дены необходимые сведения для реализации автоматизированного мо-

делирования с применением языка программирования APDL.  
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1 ОСНОВНЫЕ СВЕДЕНИЯ О КОМПЛЕКСЕ  

ANSYS MECHANICAL APDL 

 
1.1 Организация комплекса 
 

Комплекс ANSYS состоит из двух основных уровней: 

– начальный уровень; 

– модульный уровень. 

При вызове комплекса открывается начальный уровень. Начальный 

уровень используется для проведения ряда общих действий в комплек-

се, таких, как изменения имени задания, очистки базы данных и т. д.  

На модульном уровне доступны несколько модулей, каждый из ко-

торых предоставляет доступ к различным функциям и командам. Спи-

сок модулей, их функций и команд, вызывающих вход в модуль, нахо-

дится в таблице 1. 

В общем случае вызов модуля проводится из главного меню ANSYS 

Main Menu графического интерфейса пользователя (GUI). Например, вы-

зов Main Menu => Preprocessor влечет вход в модуль PREP7. В качестве 

альтернативы для входа в модуль можно использовать команду, формат 

которой выглядит как /name, где name является именем модуля.  

Для выхода на начальный уровень из модуля следует в экранном 

меню указать Main Menu Finish или вызвать команду FINISH 

(или /QUIT). Имеется возможность перехода из одного модуля в дру-

гой без возвращения в начальный уровень. Для этого достаточно ука-

зать требуемый модуль или вызвать соответствующую команду. 

Для выхода из комплекса ANSYS (и возврата в операционную си-

стему) следует вызвать из выпадающего меню Utility Menu File Exit и 

далее выбрать кнопку Exit в диалоговой панели ANSYS или использо-

вать команду /EXIT. По умолчанию комплекс сохраняет модель и 

нагрузки автоматически и записывает их в файл базы данных 

Jobname.DB.  

 
Таблица 1 – Модули ANSYS 

 

Модуль Функция Вызов из меню Команда 

1 2 3 4 

PREP7 Создание модели (построение геомет-

рии, указание материалов и т. д.) 

Main Menu => 

=> Preprocessor 

/PREP7 

SOLUTION Приложение нагрузок и получение 

расчета МКЭ 

Main Menu Solution /SOLU 
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Окончание таблицы 1 
 

1 2 3 4 

POST1 Просмотр полученных результатов 

для указанного момента времени 

Main Menu => 

=> General Postproc 

/POST1 

POST26 Просмотр полученных результатов 

для указанных точек модели в виде 

функции времени 

Mein Menu => 

=> TimeHist Postpro 

/POST26 

ОРТ Улучшение начальной модели Main Menu => 

=> Design Opt 

/ОРТ 

PDS Определение влияния разброса и рас-

пределения исходных данных на ре-

зультаты окончательного расчета 

Main Menu => Prob 

Design 

/PDS 

AUX2 Перевод двоичных файлов в форму, 

пригодную для чтения 

Utility Menu =>     

=> File => List => 

=> Binary Files 

Utility Menu =>  

=> List Files =>               

=> Binary Files 

/AUX2 

AUX12 Определение коэффициентов излу-

чения и создание матриц излучения 

для теплового расчета 

Main Menu => 

=> Radiation Matrix 

/AUX12 

AUX15 Импорт файлов, созданных сред-

ствами CAD или другими комплек-

сами МКЭ 

Utility Menu =>  

=> File => Import 

/AUX15 

RUNSTAT Предварительное определение вре-

мени расчета (CPU), ширины матри-

цы жесткости и иных характеристик 

для расчета 

Main Menu =>  

=> Run-Time Stats 

/RUNST 

 

1.2 База данных комплекса 
  

Комплекс ANSYS MECHANICAL APDL сохраняет все исходные 
данные (размеры модели, свойства материалов, данные нагрузок и т. п.) 
и расчетные результаты (перемещения, напряжения, температуры и т. 
п.) в одной организованной специальным образом базе данных. Глав-
ным преимуществом единой базы данных является возможность быст-
рого и легкого просмотра в текстовом и графическом режимах, измене-
ния и удаления любых указанных данных. 

Вне зависимости от используемого модуля работа проводится с 
одной и той же базой данных. Это позволяет обеспечить прямой доступ 
к находящейся в базе данных модели и ее нагрузкам в любом месте 
комплекса. Понятие «прямой доступ» обозначает возможность выбора, 
просмотра списка и отображения объектов. 
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Поскольку база данных содержит все исходные данные, ее следует 

регулярно сохранять в файле. Для этого следует в выпадающем меню 

указать Utility Menu => File => Save as Jobname.DB или использовать 

команду SAVE. В любом случае база данных будет записана в файл 

Jobname.DB. При использовании команды SAVE возможны следую-

щие опции: 

– сохранение только данных модели; 

– сохранение данных модели и расчета; 

– сохранение данных модели, расчета и препроцессора. 

Для указания иного имени файла следует в выпадающем меню ука-

зать Utility Menu => File => Save as или использовать требуемые аргу-

менты команды SAVE. Любая операция сохранения базы данных пред-

варительно записывает содержимое файла резервной базы данных (если 

эта база данных уже существует) в файл Jobnarae.DBB. Если файл 

Johname.DBB уже существует, он будет заменен.  

Для восстановления данных из файла базы данных следует выбрать 

в выпадающем меню Utility Menu => File => Resume Jobname.DB или 

вызвать команду RESUME. В результате будет проводиться чтение 

файла Jobname.DB. Для указания файла с иным именем следует вы-

брать в выпадающем меню Utility Menu => File => Resume from или ис-

пользовать соответствующие аргументы команды RESUME. 

Сохранение или чтение базы данных допускается в любом месте 

комплекса ANSYS, включая начальный уровень. Операция чтения за-

меняет все данные, хранящиеся в памяти в настоящий момент, на дан-

ные, сохраненные в файле базы данных. Совместное использование со-

хранения и чтения данных полезно при необходимости проверки (те-

стирования) функции или команды.  

При построении модели в ряде случаев требуется очистка базы 

данных и повторный вызов работы с комплексом. Для этого следует 

вызвать из экранного меню Utility Menu => File Clear & Start New или 

команду /CLEAR. Любой способ очистки обнуляет базу данных, нахо-

дящуюся в памяти. Очистка базы данных имеет тот же смысл, что вы-

ход из комплекса ANSYS и повторный вход в него, но не требует выхо-

да из сеанса. 

 

1.3 Графический интерфейс пользователя 
 

Существует два режима работы в ANSYS MECHANICAL APDL 

(классический вариант среды ANSYS): интерактивный и командный. 

Интерактивный режим позволяет видеть результат каждой проведенной 
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в комплексе операции. Командный режим позволяет передать команд-

ный файл или набор команд, которые будут обработаны комплексом в 

фоновом режиме.  

Наиболее простым способом работы с комплексом ANSYS является 

использование интерактивной системы меню комплекса, именуемого гра-

фическим интерфейсом пользователя (Graphical User Interface, или GUI).  

Запуск программы производится через последовательность команд 

Start => Programs => ANSYS => ANSYS Product Launcher. Появляется 

окно Product Launcher (рисунок 1). В этом окне необходимо выбрать 

рабочую директорию, название работы и др.  
 

 
 

Рисунок 1 – Окно Product Launcher 

 

Для комплекса ANSYS средства ANSYS GUI разделены на не-

сколько областей (окон), как показано на рисунке 2. К ним относятся: 

1. Utility Menu содержит сервисные функции, применяемые в ходе 

всего сеанса работы с комплексом ANSYS, как контроль файлов, кон-

троль изображения и параметры. Из данного меню также проводится 

выход из комплекса ANSYS. 

2. Icon Toolbar Menu содержит графические кнопки, которые вы-

зывают часто применяемые команды комплекса ANSYS. 

3. Input Window позволяет проводить непосредственный ввод ко-

манд. Все вызванные ранее команды содержатся в выпадающем списке 

для упрощения просмотра и доступа к ним. 

4. Toolbar – изменяемая (дополняемая) панель инструментов, со-

держащая часто применяемые команды и функции комплекса ANSYS. 

Существует возможность добавления пользовательских кнопок путем 

создания аббревиатур. 
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5. Main Menu содержит первичные функции комплекса ANSYS, 

разделенные по модулям (препроцессор, расчет, общий постпроцессор, 

модуль оптимизации и т. д.). 

6. Graphics Window – окно графического представления. 

7. Status and Prompt Area расположено внизу средств GUI, пред-

назначено для просмотра подсказки и просмотра состояния задания. 

Как правило, содержит подсказку по функциям, использующим графи-

ческое указание. При чтении подсказки можно проверить, что подле-

жащие объекты указываются в установленном порядке. Эта область 

также содержит статусную информацию (PREP7, SOLU и т. д.). 

8. Output Window – окно выходных сообщений комплекса. Обыч-

но расположено сзади остальных средств GUI, но при необходимости 

может быть перенесено на передний план. 

Вышеперечисленные средства ANSYS GUI представлены на          

рисунке 2. 

 

 
 

Рисунок 2 – Графический интерфейс пользователя 

 

Выпадающее меню Utility Menu содержит такие сервисные функ-

ции комплекса ANSYS, как контроль файлов, контроль изображения и 

параметры. Большинство этих функций могут вызываться в любое вре-

мя в ходе сеанса работы с комплексом ANSYS.  

Каждый раздел меню Utility Menu вызывает выпадающий набор 

пунктов меню, который является каскадным меню или вызывает непо-

средственное действие. Действия могут сводиться к следующему: 
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– немедленный вызов функции; 

– вызов диалогового окна; 

– вызов каскадного меню. 

Выпадающее меню Utility Menu содержит несколько разделов. 

– File содержит функции работы с файлами и базами данных, та-

кие, как очистка базы данных, сохранение в файле и чтение из файла. 

Некоторые из функций раздела File применяются только на начальном 

уровне. Если такая функция вызывается на уровне, отличающемся от 

начального, появляется диалоговая панель, в которой содержатся за-

просы перехода в начальный уровень и дальнейшего выполнения 

функции или отмены функции. 

– Select содержит функции использования активного набора объек-

тов и создания компонентов. 

– List позволяет просматривать списки любых объектов, имею-

щихся в базе данных комплекса ANSYS. Кроме того, можно получить 

информацию о состоянии различных областей регистрации программы 

и просмотреть содержимое файлов, имеющихся в компьютере. 

– Plot позволяет графически просматривать точки, линии, поверх-

ности, объемы, узлы, элементы и иные объекты, которые могут отоб-

ражаться графически. 

– PlotCtrls включает функции контроля изображения, стиля и иные 

характеристики графического отображения.  

– WorkPlane позволяет вызывать или отключать применение рабо-

чей плоскости и проводить с рабочей плоскостью операции переноса, 

вращения и иные. В данном разделе меню можно также создавать, уда-

лять и проводить переход к иной системе координат. 

– Parameters включает функции создания, редактирования и уда-

ления скалярных параметров и массивов параметров.  

– Macro позволяет вызывать макросы и блоки данных.  

– MenuCtrls позволяет проводить переключение из стандартного 

вида комплекса ANSYS в панель инструментов Mechanical Toolbar.  

– Help вызывает систему помощи ANSYS Help System. 

Панель инструментов Standard Toolbar содержит набор пикто-

грамм, вызывающих наиболее часто используемые функции.  

Стандартные кнопки и их функции включают: 

– New Analysis – сохранение и очистка информации текущего рас-

чета и начало нового расчета; 

– Open ANSYS File – чтение базы данных комплекса ANSYS или 

исходного файла; операция определяется типом файла; 

– Save Model – сохранение текущей модели в файле базы данных; 
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– Pan-Zoom-Rotate – вызов диалоговой панели Pan-Zoom-Rotate;  

– Image Capture – вызов средств сохранения изображения;  

– Report Generator – вызов средств создания отчета;  

– Context Help – отображение оглавления справки комплекса 

ANSYS, хранящейся в формате HTML. 

В пиктографическом меню Icon Toolbar Menu располагаются гра-

фические кнопки, которые вызывают часто применяемые команды: но-

вая задача, открытие файла, сохранение базы данных, управление изоб-

ражением модели, сохранение графики, создание отчета, помощь. 

Командная строка Input Window обеспечивает непосредственный 

вызов команд в текстовом виде. Вызов клавиш клавиатуры Enter вызы-

вает исполнение команды. Текст команды заносится в буфер вызван-

ных команд. Буфер вызванных команд содержит все ранее введенные 

команды. Доступ к буферу вызванных команд обеспечивается нажати-

ем на стрелку, расположенную справа от поля ввода текста. Выпадаю-

щий список содержит последовательность вызывавшихся команд. 

Щелчок левой кнопкой мыши на любой строке в буфере истории пере-

водит команду в поле ввода текста, где ее можно отредактировать и по-

вторно вызвать. Двойной щелчок на любой строке в буфере вызванных 

команд автоматически приводит к вызову данной команды. 

Панель инструментов Toolbar состоит из кнопок, вызывающих 

наиболее часто используемые функции комплекса ANSYS. Ряд кнопок 

(например, SAVE_DB и RESUM_DB) являются предварительно опре-

деленными. Существует возможность создавать другие кнопки. 

Экранное меню Main Menu содержит основные функции комплек-

са ANSYS, например, функции препроцессора, расчета и постпроцессо-

ра. Все функции экранного меню являются модульными, то есть соот-

ветствуют модулю относительно друг друга. Это значит, что для вызова 

следующей функции необходимо закончить выполнение предыдущей.  

Экранное меню Main Menu состоит из нескольких разделов: 

– Preferences – вызов диалоговой панели, позволяющей изменять 

средства контроля для контекстного фильтрования разделов меню; 

– Preprocessor проводит вход в препроцессор (путем вызова ко-

манды /PREP7) и содержит такие функции препроцессора PREP7, как 

создание модели, сетки и приложение нагрузок; 

– Solution проводит вход в модуль расчета SOLUTION (путем вы-

зова команды /SOLU) и содержит такие функции модуля SOLUTION, 

как указание типа расчета, приложение нагрузок, указание опций шагов 

нагрузки и выполнение расчета; 
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– General Postproc проводит вход в модуль общего постпроцессо-

ра (путем вызова команды /POST1) и содержит такие функции модуля 

POST1, как просмотр результатов в графическом и текстовом режимах; 

– TimeHist Postpro проводит вход в модуль повременного пост-

процессора (путем вызова команды /POST26) и вызывает просмотр ре-

зультатов средствами Time History Variable Viewer. Содержит такие 

функции модуля POST26, как создание и просмотр переменных в тек-

стовом и графическом режимах; 

– Session Editor вызывает редактор сеанса; 

– Finish вызывает выход из текущего модуля и переход на началь-

ный уровень путем вызова команды FINISH. 

Графическое окно Graphics Window предназначено для графиче-

ского отображения и проведения всего указания в графическом режиме. 

Оно является самым большим из всех окон средств GUI.  

Выходное окно Output Window содержит всю текстовую выходную 

информацию комплекса: отклики команд, заметки, предупреждения, 

ошибки и иные сообщения. Оно обычно располагается сзади средств GUI, 

но при необходимости может быть перенесено на передний план. 

 

1.4 Графическое указание объектов 
 

Многие команды комплекса требуют задания в качестве аргумен-

тов различных объектов. Например, для построения линии по точкам 

необходимо указать номера последних. Программа ANSYS позволяет 

выбирать объекты, используемые в качестве аргументов команд, непо-

средственно на экране дисплея путем их указания с помощью мыши. 

Для этих целей предусмотрены специальные панели, называемые пане-

лями указания. Они имеют стандартный вид.  

Пример такой панели показан на рисунке 3. 

При включенной кнопке Pick объекты здесь можно указывать при 

помощи левой кнопки мыши. Другая кнопка Unpick применяется для 

снятия указания. Для переключения между этими операциями можно 

также воспользоваться правой кнопкой мыши. При указании объектов 

курсор мыши имеет вид стрелки, направленной вверх, а при снятии 

указания – вид стрелки, направленной вниз. Для идентификации объек-

тов при их указании здесь используется понятие «горячей» точки. 

Например, если два объекта являются смежными, то выбирается тот, 

«горячая» точка которого наиболее близка к курсору мыши. Для по-

верхностей, объемов и конечных элементов данная точка располагается 

вблизи их центра. Линии имеют три «горячие» точки – на концах и в 
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середине. Если «горячие» точки двух или более объектов совпадают, то 

при их указании появляется панель «Multiple Entities» (совпадающие 

объекты). При этом необходимо с помощью кнопки Next (следующий) 

или Prev (предыдущий) выбрать нужный объект и нажать OK. Активи-

зация кнопки Single позволяет указывать отдельные объекты. Включе-

ние же кнопки Box, Polygon или Circle дает возможность выбора сразу 

нескольких объектов, находящихся внутри построенного курсором 

мыши прямоугольника, многоугольника или круга соответственно. 

Кнопка Loop позволяет выбирать замкнутую последовательность ли-

ний или поверхностей путем указания лишь одного объекта из этого 

набора. И наконец, кнопка Pick All используется для выбора всех объ-

ектов требуемого типа. 

 

 
 

Рисунок 3 – Панель указания 

 

1.5 Работа с файлами 
 

Комплекс при работе создает временные и постоянные файлы. 

Временные файлы отличаются от постоянных тем, что при нормальном 

выходе из комплекса временные файлы удаляются автоматически. При 

аварийном выходе из комплекса временные файлы сохраняются, и не-

которые из них следует удалять самому пользователю.  
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В состав постоянных файлов, создаваемых и применяемых при ра-
боте комплекса ANSYS, входят файлы, приведенные в таблице 2. 

Название файла (Jobname), как правило, является общим для всех 
временных и постоянных файлов и указывается при вызове сеанса ра-
боты с комплексом. 

Файлы имеют имена типа filename.ext, где filename по умолчанию 
имеет значение jobname, a ext является уникальным расширением, со-
стоящим из двух-четырех символов, определяющих содержимое файла. 
При этом jobname является именем, указанным при вызове сеанса рабо-
ты с комплексом ANSYS (при помощи команды /FILNAME или вызо-
вом последовательности Utility Menu File Change Jobname). Если значе-
ние jobname не указывается, по умолчанию применяется имя FILE. 

 
Таблица 2 – Файлы, создаваемые ANSYS 

 

Тип файла Расширение 

Log-файл Jobname.LOG 

Файл ошибок Jobname.ERR 

Файл output Jobname.OUT 

Файл базы данных Jobname.DB 

Резервный файл базы данных Jobname.DBB 

Файл результатов:  

– механический анализ; 

– термический анализ; 

– анализ магнитных полей; 

– FLOTRAN 

 

Jobname.RST 

Jobname.RTH 

Jobname.RMG 

Jobname.RFL 

Файл пошаговой нагрузки Jobname.SN 

Графический файл Jobname.GRPH 

Файл матриц элементов Jobname.EMAT 

Файл данных элементов Jobname.ELEM 

Файл с данными геометрической модели Jobname.IGES 

Файл с данными материалов Jobname.MP 

Файл с координатами узлов Jobname.NODE 

Выходной текстовый файл  Jobname.OUT 

 
В зависимости от использования файлов комплекс записывает их в 

текстовом (ASCII) или двоичном формате. Например, файлы ERR и 
LOG являются текстовыми, в то время как файлы DB, ЕМАТ и RST яв-
ляются двоичными. В общем случае файлы, необходимые для чтения и 
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редактирования, записываются в текстовом формате, а все остальные – 
в двоичном формате. 

Отдельно остановимся на LOG-файле. При работе с программой, 

как с помощью графического интерфейса пользователя, так и с помо-

щью команд, ANSYS отражает все действия в LOG-файле. LOG-файл 

представляет собой записанную историю работы с программой. Файл 

имеет расширение LOG и имеет формат записи ASCII – его можно про-

смотреть и любым внешним редактором. Этот файл представляет про-

грамму, которую можно исполнить. Для просмотра всего содержимого 

файла необходимо выполнить Utility Menu => List => Files => Log File. 

С помощью LOG-файла можно исправить ошибки, допущенные при 

работе. Для этого необходимо: 

– записать LOG-файл с помощью Utility Menu => File => Write DB 

Log File в файл, которому дать расширение txt (это необходимо для ре-

дакции файла); 

– открыть сохраненный файл, внести необходимые поправки и со-

хранить. Этот файл представляет программу, написанную с помощью 

команд; 

– очистить содержимое базы данных ANSYS с помощью Utility 

Menu => File => Clear & Start New; 

– исполнить отредактированную программу с помощью Utility 

Menu => File => Read Input from. 

 

 

2 АНАЛИЗ ЗАДАЧИ В КОМПЛЕКСЕ  

ANSYS MECHANICAL APDL 
 

Анализ любой задачи в комплексе состоит из следующих этапов: 

– предварительные настройки; 

– построение модели; 

– задание нагрузок и выполнение анализа; 

– постпроцессорная обработка результатов. 

 

2.1 Предварительные настройки 
 

Присвоение имени файлу базы данных. При выполнении этой 

операции файлу базы данных и всем сопутствующим файлам присваи-

вается новое имя. Если этого не выполнить, то файлы будут иметь имя 

по умолчанию file с соответствующим расширением. Для присвоения 
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имени необходимо выполнить путь в меню графического интерфейса 

пользователя (ГИП) и ввести свое имя файла: Utility Menu => File => 

Change Jobname. Можно также воспользоваться соответствующей ко-

мандой в строке ввода: /FILЕNAME,filename. 

Определение заголовка. Для определения заголовка необходимо 

выполнить путь в меню ГИП: Utility Menu => File => Change Title. При 

выполнении этой операции в графическом окне появится название за-

головка. Для достижения той же цели можно воспользоваться соответ-

ствующей командой: /TITLE,filename. 

Определение единиц измерения. Для перехода к системе единиц 

СИ необходимо задать команду /UNITS. Данная команда недоступна из 

ГИП и должна непосредственно вводиться в командное окно: /UNITS, SI.  

 

2.2 Построение модели 
 

Моделирование объекта – это, как правило, самый трудоемкий 
этап решения задачи. Моделирование производится в препроцессоре 
PREP7. На этом этапе исходя из математических моделей создается 
геометрическая модель объекта, определяются типы используемых ко-
нечных элементов, формируется конечно-элементная модель, задаются 
свойства материала и краевые условия.  

Построение геометрической модели. Комплекс имеет возможность 
применения следующих методов создания геометрических моделей: 

– создание геометрических моделей средствами комплекса; 
– импорт моделей, созданных средствами CAD. 
Ниже приведен краткий обзор способов создания геометрических 

моделей средствами комплекса. 
Создание модели снизу вверх. Точки, определяющие углы и концы 

ребер модели, являются геометрическими объектами самого низкого 
уровня. При создании модели сначала создаются точки, которые далее 
используются для создания геометрических объектов более высокого по-
рядка (то есть линий, поверхностей и объемов). Этот процесс называется 
созданием модели снизу вверх, или восходящим моделированием.  

Создание модели сверху вниз. Комплекс предоставляет возмож-
ность создания модели путем использования геометрических объектов, 
которые полностью определяют создаваемые линии, поверхности и 
объемы. Поскольку создается примитив, комплекс автоматически фор-
мирует все объекты более низкого уровня, связанные с ним. Если моде-
лирование начинается с создания примитивов, такой процесс называет-
ся созданием геометрической модели сверху вниз, или нисходящим мо-
делированием.  
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Пользователь может комбинировать оба метода для создания лю-
бой модели. 

Использование булевских операций. Имеется возможность форми-
рования геометрической модели, используя пересечение, вычитание и 
другие булевы операции. Булевы операции позволяют работать непосред-
ственно с геометрическими объектами высокого уровня для создания 
геометрии сложной формы. В булевых операциях можно использовать 
объекты, полученные как моделированием сверху вниз, так и снизу вверх. 

Системы координат. В комплексе применяются следующие типы 
координатных систем: 

– глобальные и локальные системы координат, используемые для 
определения местонахождения геометрических объектов (узлов, клю-
чевых точек и т. д.) в пространстве; 

– узловая система координат, определяющая направление степеней 
свободы для каждого узла и ориентацию составляющих вектора резуль-
татов в узлах; 

– система координат элемента, определяющая ориентацию харак-
теристик материала, зависящих от направления, и компонентов вектора 
результатов для элемента; 

– система координат результатов, используемая для преобразова-
ния результатов в узлах или элементах в отдельную систему координат 
для распечатки листинга, графического вывода на экран или основных 
операций в постпроцессоре общего назначения. 

Рассмотрим более подробно каждую из координатных систем. 
Глобальная система координат – это всеобщая или абсолютная 

система. В программе ANSYS предусмотрено использование трех 
предопределенных глобальных систем: декартовой, цилиндрической и 
сферической. Все три системы правосторонние, имеют одно и то же 
начало и идентифицируются следующим образом:  

0 – декартова,  
1 – цилиндрическая, 
2 – сферическая. 
Локальная система координат. Во многих случаях у пользовате-

ля возникает необходимость установить собственную систему коорди-
нат, начало которой не совпадает с началом глобальной системы коор-
динат или ориентация которой отличается от ориентации предопреде-
ленной глобальной системы.  

Локальная система координат может быть декартовой, цилиндри-
ческой или сферической. Кроме того, может быть задана тороидальная 
локальная система координат. Когда локальная система координат 
определена, она становится активной. При создании локальной системы 
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ей нужно присвоить идентифицирующий номер, который должен быть 
больше 10. Локальные системы координат могут быть созданы не-
сколькими способами. Например, задание локальной системы с исполь-
зованием глобальной декартовой системы координат: Utility Menu => 
=> WorkPlane => Local Coordinate Systems => Create Local CS => AT 
Specified Loc (рисунок 4). 

 

 
 

Рисунок 4 – Задание локальной системы с использованием  

глобальной декартовой системы координат 
 

В диалоговом окне Create Local CS at Specified Location нужно 

указать следующие параметры. 

В поле KCN Ref number of new coord sys вводим номер системы 

координат, который должен быть больше 10. Если уже есть система ко-

ординат с таким номером, то она будет переопределена. 

В поле KCS Type of coordinate system необходимо выбрать тип си-

стемы координат (Cartesian 0 – декартова, Cylindrical 1 – цилиндриче-

ская, Spherical 2 – сферическая и Toroidal 3 – тороидальная). 

В поле XC, YC, ZC Origin of coord system вводим координаты 

начала системы координат. 

В полях THXY Rotation about local Z, THYZ Rotation about local X, 

THZX Rotation about local Y вводим значения углов, на которые необ-

ходимо повернуть систему относительно осей глобальной декартовой 

системы координат. 

Локальные системы координат можно создавать либо удалять в любой 

момент работы с программой. Удалить локальную систему координат 

можно следующим образом: Utility Menu => WorkPlane => Local Coordinate 

Systems => Delete Local CS. 
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В диалоговом окне Delete Local CS в строке KCN1 Delete coord system 

from нужно указать номер удаляемой локальной системы координат.  

Для просмотра статуса всех глобальных и локальных систем коор-

динат выполним следующее: Utility Menu => List => Othebnr => Local 

Coord Sys. 

Систем координат может быть задано столько, сколько требуется, 

но активной в данный момент может быть только одна. Изначально ак-

тивной является глобальная декартова система. Вновь введенная систе-

ма автоматически становится активной. Если нужно активизировать 

одну из глобальных систем координат или одну из предварительно за-

данных необходимо проделать следующую операцию: Utility Menu => 

=> Work Plane => Change Active CS to. 

В то время как глобальные и локальные системы координат обеспе-

чивают возможность создания геометрических объектов, узловая систе-

ма координат ориентирует направления степеней свобод в каждом узле. 

Каждый узел имеет свою собственную узловую систему координат, кото-

рая по умолчанию параллельна декартовой глобальной системе (незави-

симо от активной системы координат, в которой узел был создан).  

Вращение узловой системы координат, в результате которого оси 

узловой системы координат становятся параллельными соответствую-

щим осям активной системы координат, осуществляется следующим 

образом: Main Menu => Preprocessor => Create => Nodes => Rotate Node 

CS => To Active CS или Main Menu => Preprocessor => Move/Modify => 

=> Rotate Node CS => To Active CS. 

Поворот узловой системы координат на углы, задаваемые пользовате-

лем, осуществляется следующим образом: Main Menu => Preprocessor => 

=> Create => Nodes => Rotate Node CS => By Angles или Main Menu => 

=> Preprocessor => Move/Modify => Rotate Node CS => By Angles. 

Просмотр углов поворота узловой системы координат относительно 

осей глобальной координатной системы: Utility Menu => List => Nodes. 

Каждый элемент имеет свою собственную систему координат – эле-

ментную систему координат, которая определяет направление осей 

свойств ортотропных материалов, приложенных давлений и результа-

тов (напряжений и деформаций) для этого элемента.  

Сначала создается локальная система координат с необходимыми 

углами поворота относительно осей глобальной системы координат, а 

затем в атрибутах элементов указывается номер созданной локальной 

системы координат: Main Menu => Preprocessor => Modeling => 

=> Move/Modify => Elements => Modify Attrib – нажмите кнопку Pick 

All и введите данные (рисунок 5). 
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Рисунок 5 – Задание системы координат элементов 

 

Выходные данные (результаты), вычисляемые в ходе решения, 

хранятся в базе данных и в файле результатов в узловой системе коор-

динат, и в элементной системе координат. При представлении результа-

тов они переводятся в активную систему координат результатов (кото-

рая является по умолчанию глобальной декартовой системой) для изоб-

ражения, просмотра в текстовом виде и сохранения в таблицах. 

Изменение системы координат результатов: Main Menu => 

=> General Postproc => Options for Output. Допустимо изменение актив-

ной системы координат результатов на другой ее тип (например, на 

глобальную цилиндрическую систему, на локальную систему коорди-

нат или на систему координат результатов).  

Рабочая плоскость. Отметим, что хотя курсор является точкой 

на экране дисплея, в действительности он представляет линию в про-

странстве, перпендикулярную плоскости экрана. Для того чтобы с по-

мощью курсора можно было задавать местоположение точек, здесь 

необходимо определить воображаемую плоскость, точка пересечения 

линии курсора с которой будет давать единственную точку в простран-

стве. Эта воображаемая плоскость и называется рабочей плоскостью 

(Working Plane). В программе ANSYS она играет важную роль. Напри-

мер, построение геометрических примитивов всегда выполняется отно-

сительно рабочей плоскости. 

По умолчанию рабочая плоскость совпадает с плоскостью XY гло-

бальной декартовой системы координат. Однако с помощью команд, 

сосредоточенных в подменю Utility Menu => WorkPlane => Align WP 

with, можно определить новую рабочую плоскость. Например, команда 

Keypoints позволяет строить рабочую плоскость по трем точкам, кото-

рые определяют начало, ось x и плоскость xy. 

Для перемещения рабочей плоскости следует воспользоваться ко-

мандами подменю Utility Menu => WorkPlane => Offset WP to. 
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При этом начало системы координат рабочей плоскости можно пе-

ренести в заданную точку, узел или начало активной системы коорди-

нат. Кроме того, последовательность Utility Menu => WorkPlane =>          

=> Offset WP by Increments позволяет перемещать и поворачивать рабо-

чую плоскость путем задания трех смещений и трех углов поворота от-

носительно осей ее системы координат. 

Построение конечно-элементной модели. Для решения задачи в 

комплексе требуется расчетная (конечно-элементная) модель, причем 

геометрическая информация в расчетах вообще не используется. 

Построение МКЭ-модели – это процесс получения узлов и элемен-

тов, адекватно описывающих геометрию тела. Для этих целей в ком-

плексе предусмотрены два метода:  

 метод, базирующийся на геометрическом моделировании (solid 

modeling); 

 прямое генерирование (direct generation).  

В первом случае сначала описывается геометрия тела, а затем гео-

метрические объекты автоматически разбиваются программой на ко-

нечные элементы. При этом имеется возможность управлять размером 

и формой создаваемых таким образом элементов.  

Во втором случае приходится вручную определять положение 

каждого узла и связи каждого элемента.  

Очевидно, что метод, базирующийся на геометрическом моделиро-

вании, является более мощным и универсальным, нежели прямое гене-

рирование, и чаще используется на практике. Однако метод прямого 

генерирования обеспечивает более полный контроль над геометрией и 

нумерацией каждого узла и элемента. Поэтому иногда возникают ситу-

ации, где данный метод становится более предпочтительным. 

Определение типа элемента. Библиотека элементов ANSYS со-

держит более 100 различных типов конечных элементов. Каждый эле-

мент имеет свое имя, описывающее семейство элементов, необходимых 

для моделирования соответствующего объекта, и номер. В таблице 2 

приведены некоторые из них. 

Типом элемента определяются: 

 степени свободы элемента, которые влияют и на тип анализа 

(механический, термический, магнитный, электрический); 

 модель объекта (одномерная, двумерная или трехмерная). 

Для выбора нужного типа элемента необходимо выполнить путь в 

меню ГИП: Main Menu => Preprocessor => Element Type => 

=> Add/Edit/Delete => Add или использовать команду в строке ввода: 

ET,ITYPE,ENAME. 
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Таблица 2 – Основные типы конечных элементов ANSYS 
 

Имя элемента Моделирование 

LINK Моделирование ферменных конструкций, тросов, канатов и т. д. 

SHELL Моделирование тонкостенных конструкций  

PLANE 
Моделирование двумерных задач (плоская задача, плоскона-

пряженное состояние, осесимметричная задача) 

SOLID Моделирование трехмерных объектов 

CONTAC Моделирование условий контакта 

 

Приведем в качестве примера некоторые типы элементов доступные 

для теплового анализа (таблица 3). 
 

Таблица 3 – Типы элементов для теплового анализа в ANSYS 
 

Элемент Размерность Вид, характеристика 

PLANE35 2D Треугольник, шесть узлов 

PLANE55 2D Четырехугольник, четыре узла 

PLANE77 2D Четырехугольник, восемь узлов 

SOLID70 3D Блок, восемь узлов 

SOLID87 3D Тетраэдр, десять узлов 
 

Определение опций элемента. У каждого типа элементов обычно 
необходимо задать опции. Эти опции позволяют управлять различными 
параметрами элемента. 

Например, у элемента SOLID95 следующие опции: 
 выбор локальной системы координат, связанной с элементом; 
 выбор точек, в которых происходит вычисление данных (напри-

мер, напряжений) внутри элемента; 
 выбор точек, в которых происходит вычисление данных на по-

верхности элемента; 
 правило численного интегрирования для построения. 
Более подробно о том, какие опции допускает соответствующий тип 

элемента, необходимо смотреть в разделе помощи по каждому элементу.  
Для выбора нужных опций элемента необходимо выполнить путь в 

меню ГИП: Main Menu => Preprocessor => Element Type => 
=> Add/Edit/Delete => Options  или использовать команду в строке 
ввода: KEYOPT,ITYPE,KNUM,VALUE. 

Определение констант элемента. В основном константы задаются 
для элементов, которые используются для моделирования трехмерных 
моделей сплошной среды моделями низшей размерности, например, в 
случае ферменных, балочных и оболочечных элементов.  
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Константы элемента зависят от типа элемента. Так, например, кон-
станты для элемента BEAM3, 2D балочного элемента – это площадь се-
чения (AREA), момент инерции (IZZ), высота сечения (HEIGHT), кон-
станта сдвига (SHEARZ), начальная деформация (ISTRN) и добавлен-
ная масса (ADDMAS). Не все элементы требуют определения констант. 

Для задания констант элемента необходимо выполнить путь в ме-
ню ГИП: Main Menu => Preprocessor => Real Constants => 
=> Add/Edit/Delete или использовать команду в строке ввода: 
R,NSET,R1,R2,R3,R4,R5,R6. 

Генерация сеток конечных элементов. Процедура построения 
узлов и конечных элементов состоит из следующих основных шагов: 

 назначение объектам атрибутов элементов; 
 установка параметров управления сеткой конечных элементов; 
 генерация сетки элементов. 
Можно назначить разные атрибуты элементов различным частям 

модели. При этом используются соответствующие ссылочные номера, 

включающие номер материала (MAT), номер набора «реальных» по-

стоянных (REAL), номер типа элементов (TYPE), номер локальной си-

стемы координат, применяемой в качестве системы координат элемента 

(ESYS), и номер сечения (SECNUM). Здесь можно либо назначить ат-

рибуты выбранным геометрическим объектам модели тела (до их раз-

бивки на элементы), либо определить активный набор атрибутов (по 

умолчанию MAT = 1, REAL = 1, TYPE = 1, SECNUM = 1), который бу-

дет использоваться для всех конечных элементов, создаваемых в после-

дующих операциях построения сеток. 

Для назначения атрибутов непосредственно геометрическим объ-

ектам (точкам, линиям, поверхностям и объемам) применяется один из 

следующих методов: 

Main Menu => Preprocessor => Meshing => Mesh Attributes => 

All Keypoints (всем точкам); 

Picked KPs (указанным точкам); 

All Lines (всем линиям); 

Picked Lines (указанным линиям); 

All Areas (всем поверхностям); 

Picked Areas (указанным поверхностям); 

All Volumes (всем объемам); 

Picked Volumes (указанным объемам). 

Для определения активного набора атрибутов доступны два варианта: 

Main Menu => Preprocessor => Meshing => Mesh Attributes =>                

=> Default Attribs; 
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Main Menu => Preprocessor => Modeling => Create => Elements => 

=> Elem Attributes. 

Следует отметить, что атрибуты, назначенные геометрическим 
объектам, подавляют текущие активные атрибуты. При генерации сеток 
конечных элементов, если объекту назначены атрибуты, именно они 
будут автоматически присваиваться создаваемым там элементам. 

Основная предпосылка МКЭ-расчетов заключается в том, что по 
мере увеличения количества элементов (плотности сетки) решение схо-
дится к точному. Однако при этом возрастают потребные ресурсы 
ЭВМ. Здесь необходимо найти баланс между точностью и скоростью 
решения задачи. Таким образом, при практическом использовании 
МКЭ часто встает вопрос о том, сколько для получения приемлемой 
точности следует взять конечных элементов. В отсутствие опыта здесь 
приходится экспериментировать, начиная с грубой сетки и далее сгу-
щая ее и исследовать сходимость решения. 

Необходимо помнить, что МКЭ – приближенный метод, точность 
которого зависит от правильного выбора типов и размеров конечных 
элементов. Так, например, более мелкая сетка требуется там, где ожи-
даются большие градиенты напряжений. В то же время более грубая 
сетка может применяться в зонах с более или менее постоянными 
напряжениями, а также в областях, не представляющих особого инте-
реса. В связи с этим пользователь должен предвидеть области концен-
трации напряжений. 

Следует отметить, что форму элементов необходимо задавать лишь 
для тех типов элементов, которые допускают использование более од-
ной формы. 

Например, многие поверхностные элементы могут иметь как тре-
угольную, так и четырехугольную форму, а объемные – как форму тет-
раэдра, так и гексаэдра. 

Размер генерируемых программой конечных элементов определя-
ется путем задания либо длины стороны элемента (Element edge length), 
либо числа делений линии на элементы (No. of element divisions).  

Определение глобального размера элементов: 
Main Menu => Preprocessor => Meshing => Size Cntrls => ManualSize => 

=> Global => Size. 
Определение размера элементов вблизи точек: 
Main Menu => Preprocessor => Meshing => Size Cntrls => ManualSize 

=> Keypoints => All KPs (Picked KPs). 
Определение размера элементов на линиях: 

Main Menu => Preprocessor => Meshing => Size Cntrls => ManualSize 

=> Lines => All Lines (Picked Lines). 
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Перечисленные выше команды можно использовать вместе. При 
этом для разрешения конфликтных ситуаций здесь имеется определен-
ная иерархия. Например, локальные установки подавляют глобальные. 
Глобальный размер элементов используется лишь для тех объектов, для 
которых не определены какие-либо другие параметры разбивки. 

Если параметры управления сеткой вообще не заданы, комплекс вы-
бирает размер элементов, исходя из минимального и максимального коли-
чества делений, соотношения сторон и, прежде всего, порядка элемента.  

Автоматическое разбиение геометрических объектов на конечные 
элементы осуществляется с помощью команд генерации сеток (Meshing). 

Генерация точечных элементов: 
Main Menu => Preprocessor => Meshing => Mesh => Keypoints. 
Генерация линейных элементов: 
Main Menu => Preprocessor => Meshing => Mesh => Lines. 
Генерация поверхностных элементов:  
Main Menu => Preprocessor => Meshing => Mesh => Areas => 

=> Mapped => 3 or 4 sided, 
Main Menu => Preprocessor => Meshing => Mesh => Areas => Free. 
Генерация объемных элементов: 
Main Menu => Preprocessor => Meshing => Mesh => Volumes => 

=> Mapped => 4 or 6 sided.  
Main Menu => Preprocessor => Meshing =>  Mesh => Volumes => Free. 
Здесь следует отметить, что для поверхностей и объемов програм-

ма ANSYS использует два типа сеток: свободные (free) и регулярные 
(mapped). 

При этом генерация свободных сеток возможна на любых поверх-
ностях или объемах без ограничений. При разбиении поверхностей 
свободная сетка может состоять из четырехугольных и треугольных 
элементов (смешанная сетка) или только из треугольных элементов. 
Однако при разбиении объемов здесь используются лишь элементы, 
имеющие форму тетраэдра (смешанная сетка не допускается). Генера-
ция регулярных сеток требует, чтобы поверхности и объемы были 
«правильными», т. е. удовлетворяли определенным критериям. Так, по-
верхности должны быть трех- или четырехсторонними, а объемы – ше-
стигранными (гексаэдр), пятигранными (клин, призма) или четырех-
гранными (тетраэдр). Заданное количество делений на сторонах здесь 
также должно удовлетворять некоторым критериям. При этом регуляр-
ная сетка на поверхностях состоит только из четырехугольных элемен-
тов, а в объемах – из шестигранных. Отметим, что регулярная сетка яв-
ляется более экономичной и более удобной при анализе результатов 
расчета. Однако во многих случаях геометрия модели такова, что         
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составляющие ее поверхности имеют более четырех сторон, а объемы – 
более шести граней.  

Для преобразования объектов в регулярные здесь может потребо-
ваться один из следующих приемов:  

– разделение поверхностей (объемов) на части меньших размеров и 
более простой формы при помощи булевой операции деления (divide). 
При этом в качестве режущего инструмента удобно использовать рабо-
чую плоскость, которая легко устанавливается в нужное положение.  

– применение операции конкатенации (concatenate) для уменьше-
ния числа сторон (граней) путем «фиктивного» объединения (только в 
целях разбивки) двух или более линий (поверхностей): Main Menu => 
=> Preprocessor => Meshing => Concatenate => Lines (Areas).  

Для удобства пользователя все перечисленные выше команды объ-
единены в одной диалоговой панели «Mesh Tools» (рисунок 6), которая 
появляется при выполнении следующей последовательности команды: 
Main Menu => Preprocessor => Meshing => Mesh Tools.  

 

 
 

Рисунок 6 – Инструментарий для построения сеток 
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Определение свойств материала. В зависимости от задачи в 

ANSYS могут быть заданы следующие свойства материала:  

– линейные или нелинейные;  

– изотропные, ортотропные и анизотропные;  

– зависящие от температуры или независящие.  

Для задания свойств материала необходимо выполнить путь в ме-

ню ГИП: Main Menu => Preprocessor => Material Props или использовать 

команду в строке ввода: MP,Lab,MAT,C0,C1,C2,C3,C4. 

Команда MP позволяет задать свойство, зависящее от температу-

ры, в виде полинома. Полином может быть линейным, квадратичным, 

кубическим или полиномом четвертого порядка:  
 

Свойство = C0 + C1∙T + C2∙T
2
 + C3∙T

3
 + C4∙T

4
 

 

Если задано только C0, то свойство материала будет постоянным; 

если задается C0 и C1, то свойство материала будет линейно зависеть 

от температуры и т. д.  

Когда задано свойство, зависящее от температуры, указанным вы-

ше образом, программа вычисляет полином в дискретных температур-

ных точках с линейной интерполяцией между точками.  

Второй способ задания зависящих от температуры свойств заклю-

чается в использовании комбинации команд MPTEMP и MPDATA.   

MPTEMP задает серию температур, и MPDATA задает соответству-

ющие значения свойства материала. Например, следующие команды опре-

деляют зависящую от температуры теплопроводность для материала 1:  

MPTEMP,1,10,20,30, , , , 

MPDATA,KXX,1,1,1.1,1.2,1.3, , , 

 

2.3 Задание нагрузок и выполнение анализа 
 

Выбор типа анализа и задания спецификации решения. На этом 

этапе решения задач в комплексе используется блок решения (Solution). 

Необходимо выбрать тип анализа и задать его опции.  

Комплекс позволяет выполнять следующие типы анализов:  

 Static – статический анализ (задается по умолчанию);  

 Modal – модальный анализ (т. е. расчет частот и форм собствен-

ных колебаний);  

 Harmonic – гармонический анализ (т. е. расчет вынужденных ко-

лебаний конструкции при действии нагрузок, изменяющихся по сину-

соидальному закону);  
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 Transient – анализ переходных динамических процессов (как 

правило, кратковременных, например, ударного характера);  

 Spectrum – спектральный анализ (т. е. анализ случайных колебаний);  

 Eigen Buckling – анализ начальной устойчивости (линеаризован-

ный подход); 

 Substructuring – анализ подконструкций (суперэлементов).  

Для выбора типа анализа необходимо выполнить путь в меню 

ГИП: Main Menu => Preprocessor => Loads => Analysis Type => New 

Analysis или использовать команду в строке ввода: ANTYPE,                     

Antype,Status. 

На этом этапе в зависимости от типа выбранного решения, а также 

в зависимости от типа задачи определяются следующие параметры: 

 выбор метода решения получаемых систем уравнений;  

 задание параметров решения (шаг нагрузки, количество шагов, шаг 

интегрирования, количество определяемых собственных форм и др.);  

 задание точности решения;  

 задание параметров записи результатов в файл и др.  

Опции анализа дают возможность уточнить параметры проводимо-

го расчета. Для задания опций анализа можно воспользоваться универ-

сальной диалоговой панелью «Solution Controls», вызываемой по пути в 

меню ГИП: Main Menu => Solution => Analysis Type => Sol’n Controls 

(рисунок 7).  

 

 
 

Рисунок 7 – Диалоговая панель «Solution Controls» 
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Следует отметить, что решение системы линейных алгебраических 
уравнений может выполняться от долей секунды до нескольких часов в 
зависимости от размера задачи и характеристик компьютера. Линейный 
статический расчет требует одного такого решения, а нелинейный или 
динамический расчет может потребовать десятков, сотен или даже ты-
сяч решений. Поэтому важно правильно выбирать метод решения.  

Для решения систем уравнений в комплексе применяют как пря-
мые, так и итерационные методы. Каждый подход обладает определен-
ными преимуществами и недостатками, но чаще всего в настоящее 
время пользуются все же прямыми методами, основанными на исклю-
чении по Гауссу.  

Имеющиеся в комплексе методы решения систем уравнений делят-
ся на три группы:  

1) прямые: Frontal direct – фронтальный метод, Sparse direct – для 
разреженных матриц, т. е. содержащих много нулей (выбирается по 
умолчанию);  

2) итерационные: PCG – предобусловленный метод сопряженных 
градиентов, ICCG – метод сопряженных градиентов c неполным разло-
жением Холецкого, JCG – метод сопряженных градиентов Якоби;  

3) для параллельных вычислений: AMG – метод, используемый в 
многопроцессорных компьютерах, DDS – метод, применяемый при 
наличии распределенной вычислительной системы.  

В большинстве случаев выбираемый по умолчанию метод Sparse 
direct обеспечивает хорошую надежность и скорость решения. Метод 
Frontal direct рекомендуется использовать тогда, когда важна надеж-
ность или при ограниченной памяти ЭВМ. Отличительной особенно-
стью фронтального метода является то, что он не требует построения 
полной матрицы жесткости конструкции. При его использовании вы-
полняется формирование только тех уравнений, которые необходимы 
для исключения очередных неизвестных (степеней свободы). Итераци-
онный метод PCG обеспечивает высокую скорость решения для боль-
ших систем, особенно при использовании объемных элементов. Метод 
ICCG эффективен в задачах мультифизики, а JCG рекомендуется ис-
пользовать в тех случаях, когда в каждом узле определяется лишь одна 
степень свободы (как в тепловом анализе). 

Приложение нагрузок. Нагрузки в комплексе разделяются на 

шесть категорий:  

 DOF Constraints – ограничения степеней свободы (граничные 

условия);  

 Forces – сосредоточенные силы и моменты;  
 Surface Loads – поверхностные нагрузки (например, давление);  
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 Body Loads – объемные нагрузки (например, температура);  
 Inertial Loads – инерционные нагрузки, связанные с массой кон-

струкции (возникают при действии: ускорения свободного падения, пе-
регрузок, угловой скорости и углового ускорения);  

 Coupled-field Loads – нагрузки связанных полей (используются 
для передачи результатов расчета одного анализа в качестве нагрузки 
для другого анализа).  

Большинство из перечисленных выше нагрузок можно приклады-
вать либо к геометрическим объектам (т. е. к точкам, линиям, поверх-
ностям и объемам), либо непосредственно к конечно-элементной моде-
ли (т. е. к узлам и элементам). Первый способ представляется более 
удобным, поскольку определять нагрузки на геометрических объектах 
можно как до, так и после разбиения модели на конечные элементы. 
Кроме того, приложенные таким образом нагрузки не пропадут и при 
модификации сетки элементов. Следует отметить, что при запуске за-
дачи на счет эти нагрузки будут автоматически переноситься на соот-
ветствующие узлы и конечные элементы. 

Приведем в качестве примера типы тепловых нагрузок (таблица 4). 
 

Таблица 4 – Типы тепловых нагрузок в ANSYS 
 

Тип нагрузки 
Единицы  

измерения 

Семейство 

команд 
Путь в меню 

Температура 

(Temperature) 
K D 

Main Menu => Solution => Define 

Loads => Apply => Therma l => 

=> Temperature 

Тепловой поток 

(Heat Flow) 
Дж/с F 

Main Menu => Solution => Define 

Loads => Apply => Thermal => Heat 

Flow 

Конвекция 

(Convection) 
Вт/ К·м

2
 SF 

Main Menu => Solution => Define 

Loads => Apply => Thermal => 

=> Convection 

Плотность 

теплового потока 

(Heat Flux) 

Дж/с·м
2
 SF 

Main Menu => Solution => Define 

Loads => Apply => Thermal => Heat 

Flux 

Энерго-выделение 

(Heat Generat) 
Дж/с·м

3
 BF 

Main Menu => Solution => Define 

Loads => Apply => Thermal => Heat 

Generat 

 

Ввод нагрузок возможен в модуле Solution. Приведем в качестве 

примера путь в меню ГИП для задания значений  температур: 

Main Menu => Solution => Loads => Define Loads => Apply =>                

=> Structural => Temperature => 
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 On Keypoints (в точках); 

 On Lines (на линиях); 

 On Areas (на поверхностях); 

 On Nodes (в узлах); 

 On Elements (в элементах); 

 Uniform Temp (единой для всей модели). 

С целью проверки приложенных нагрузок может потребоваться за-

ново отрисовать соответствующие им символы. Это можно сделать путем 

активизации нужных опций диалоговой панели «Symbols», появляющей-

ся при выборе пункта меню Utility Menu => PlotCntrs => Symbol.  

Для вывода списка заданных нагрузок следует воспользоваться 

пунктами меню Utility Menu => List => Loads. 

Запуск задачи на счет. Для запуска задачи на счет используется 

следующий путь ГИП: Main Menu => Solution => Solve => Current LS. 

При этом комплекс берет из базы данных информацию по конечно-

элементной модели и текущему шагу нагружения и вычисляет решение.  

Если после завершения счета, не выходя из блока решения, изменить 

условия нагружения и снова отправить задачу на решение, то будет полу-

чено решение для следующего шага и т. д. Результаты расчетов записы-

ваются в файл результатов (Jobname.rst), а также в базу данных. При этом 

в базе данных может храниться только один набор результатов, тогда как 

в файле могут быть записаны результаты для всех шагов решения.  

Если предварительно с пунктов меню Main Menu => Solution => 

=> Load Step Opts => Write LS File записать последовательно шаги нагру-

жения в текстовые файлы (именуемые Jobname.s01, .s02, .s03 и т. д.), то 

тогда можно будет за один раз получить решения сразу для нескольких 

шагов по нагрузке: Main Menu => Solution => Solve => From LS Files. 

 

2.4 Постпроцессорная обработка результатов 
 

Как только решение завершено, можно получить доступ к резуль-

татам, используя, в зависимости от типа задачи, два постпроцессора – 

POST1 и POST26.  

Постпроцессор POST1 (General Postprocessor – общий постпроцес-

сор) используется для обзора результатов в стационарной задаче или в 

течение отдельного шага решения в нестационарной задаче. Путь в 

ГИП: Main Menu => General Postproc или команда /POST1.  

Постпроцессор POST26 (Time History Postprocessor – временной 

постпроцессор) используется для обзора результатов, зависящих от 
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времени. Путь в ГИП: Main Menu => Time Hist Postpro или команда 

/POST26. 

Общий постпроцессор предусматривает следующие виды графиче-

ского изображения выходных величин:  

 Contour Plot – контурное изображение;  

 Deformed Shape – изображение деформированного состояния;  

 Vector Plot – векторное изображение;  

 Path Plot – изображение изменения величины вдоль определен-

ной пользователем траектории;  

 Reaction Force Display – изображение сил реакции.  

Рассмотрим некоторые из них. Так, контурное изображение ис-

пользуется для многоцветного представления на модели поля выходной 

величины (например, компонента вектора перемещения, тензора напря-

жений и т. п.). Здесь доступны следующие команды: Main Menu =>          

=> General Postproc => Plot Results => Contour Plot => 

Nodal Solu (узловое решение); 

Element Solu (элементное решение);  

Elem Table (результаты из таблицы элементов);  

Line Elem Res (результаты линейных элементов).  

При этом пункт меню Nodal Solu используется для вычерчивания 

непрерывных контурных линий.  

Строка Element Solu предназначена для вычерчивания контурных 

линий, которые терпят разрыв на границах элементов. Этой командой 

обычно изображаются поля производных величин.  

Следующий пункт меню Elem Table используется для построения 

контурных изображений величин, хранящихся в таблице элементов.  

На практике при обработке результатов расчета часто приходится 

строить двухмерные графики различных выходных величин. Комплекс 

позволяет строить такие графики вдоль определенной пользователем 

траектории. Для создания траектории путем прямого указания лежащих 

на ней узлов доступен следующий пункт меню: Main Menu => General 

Postproc => Path Operations => Define Path => By Nodes.  

Здесь после указания узлов появляется диалоговая панель (рису-

нок 8), где в поле Define Path Name необходимо задать имя создаваемой 

траектории, в поле Number of data sets определяется максимально воз-

можное число выходных величин, отображаемых на траектории, в поле 

Number of divisions указывается число промежуточных отрезков, созда-

ваемых между каждой парой узлов, определяющих траекторию (чем 

больше промежуточных точек, тем более гладким получается график). 
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Рисунок 8 – Диалоговая панель определения траектории  

 

Затем следует выбрать выходные данные, предназначенные для 
отображения вдоль созданной траектории: Main Menu => General              
Postproc => Path Operations => Map onto Path.  

Здесь каждой величине необходимо присвоить имя (нельзя исполь-
зовать зарезервированные имена XG, YG, ZG и S). После того как ин-
тересующая величина привязана к кривой, можно получить зависи-
мость этой переменной от выбранного пути в табличной форме: Main 
Menu => General Postproc => Path Operations => Plot Path Item => List 
Path Items или в виде двухмерного графика: Main Menu => General 
Postproc => Path Operations => Plot Path Item => On Graph.  

К выделенным таким образом массивам значения возможно при-
менение ряда математических операций (таких как интегрирование, 
дифференцирование, умножение, скалярное и векторное произведение). 

Представление результатов в постпроцессоре истории нагружения. 

В общем случае в постпроцессоре истории нагружения все операции вы-
зываются из соответствующей диалоговой панели (рисунок 9), которая по-
является автоматически при входе в соответствующий раздел программы. 

 

 
 

Рисунок 9 – Диалоговая панель для работы с переменными  

в постпроцессоре истории нагружения 
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Работа во временном постпроцессоре предполагает определение 

так называемых переменных (Variables), которые описывают поведение 

модели в конкретных ее точках в ходе всей истории нагружения, и 

дальнейшие операции с этими переменными.  

Диалоговая панель для работы с переменными включает в себя па-

нель инструментов, список переменных и калькулятор.  

В состав панели инструментов входят следующие пиктограммы:  

 Add Data – создание новой переменной;  

 Delete Data – удаление ранее созданной переменной;  

 Graph Data – изображение переменной на экране в виде графика;  

 List Data – вывод списка значений переменной в текстовом виде;  

 Data Properties – указание свойств переменных;  

 Import Data – импорт значений переменной из внешнего файла;  

 Export Data – экспорт значений переменной в массив или внеш-

ний файл;  

 Overlay Data – замена данных;  

 Clear Time-History Data – удаление всех переменных;  

 Refresh Time-History Data – обновление списка переменных. 

Список переменных (Variable List) содержит собственно имена пе-

ременных (определяются пользователем), а также номера узлов и эле-

ментов, на основе которых были получены данные переменные, тип пе-

ременной (перемещение, напряжение и т. п.), минимальное и макси-

мальное значения переменной и признак использования переменной в 

качестве оси абсцисс при построении графика.  

Калькулятор (Calculator) содержит кнопки, позволяющие выпол-

нять различные операции для создания новых переменных на основе 

существующих. Например, после определения переменной для пере-

мещения при анализе переходного динамического процесса можно вы-

числить скорость или ускорения путем применения операции диффе-

ренцирования по времени.  

Для получения новой переменной на базе имеющихся необходимо 

в верхнем поле калькулятора присвоить ей уникальное имя и в сосед-

нем поле (после знака равенства) ввести соответствующее выражение, 

используя кнопки калькулятора. При этом выбор существующих пере-

менных осуществляется из второго списка. Ввод новой переменной за-

вершается нажатием кнопки ENTER. 
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3 АВТОМАТИЗИРОВАННОЕ МОДЕЛИРОВАНИЕ 

В КОМПЛЕКСЕ ANSYS MECHANICAL APDL 

 
Начиная работать с комплексом, пользователи обычно имеют дело 

с интерактивным режимом – вся работа ведется через меню. Такой ва-

риант работы позволяет получить доступ к большинству функций и для 

большинства задач является достаточным. Однако некоторые операции 

и целые расчеты проще проводить, используя встроенный командный 

язык. APDL – это аббревиатура для ANSYS Parametric Design Language. 

APDL – язык программирования, позволяющий создавать параметриче-

ские модели и автоматизировать рутинные операции.  

Используя APDL, можно:  

 вводить размеры, свойства и т. д., с помощью параметров, а 

не чисел;  

 получать информацию из базы модели;  

 производить математические операции над параметрами;  

 создавать макросы с набором команд; 

 создавать параметрические модели. 

Большинство операций, которые пользователь выполняет при ра-

боте с программой, могут быть заменены командами. Есть два про-

стейших способа знакомства с языком.  

Во-первых, при нажатии кнопки Help в любом диалоговом окне 

выводится помощь по данной операции, включая описание соответ-

ствующей команды.  

Второй способ состоит в том, что во время работы пользователя 

все команды заносятся в log-файл. Это текстовой файл, который можно 

смотреть в любом текстовом редакторе.  

По мере работы с программой пользователь может изучать коман-

ды, которые он чаще использует. Команды можно передать в програм-

му двумя способами.  

Первый подходит для ввода единичных команд – они вводятся в 

командную строку. Второй – это использование batch-файла. Batch-

файл – это командный файл, выполняющийся в пакетном режиме. Этот 

файл может быть получен на основе log-файла. Чтобы использовать 

batch-файл, нужно вызвать меню Utility Menu => File => Read Input и 

указать имя файла, который следует считывать ANSYS для получения 

входных команд и их параметров. Кроме batch-файла возможна реали-

зация автоматизации моделирования с использованием mac-файла. 

Mac-файл – это файл с наборами команд и макрокоманд APDL. При за-
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пуске макроса используется механизм передачи параметров, позволя-

ющий передать аргументы внутрь макропрограммы. Mac-файл, как и 

batch-файл, можно создать в любом текстовом редакторе. Для вызова 

макрофайла необходимо вызвать меню Utility Menu => Macro => 

=> Execute Macro, указать имя макро-файла и его входные параметры. 

 

3.1 Команды комплекса 
 

Команды комплекса имеют заранее определенный формат. В об-

щем случае команда состоит из имени команды, стоящего первым в 

строке, и нескольких полей, содержащих аргументы команды. Напри-

мер, команда F, прикладывающая сосредоточенную силу к узлу, имеет 

следующий вид: F,NODE,Lab,VALUE 

Для приложения к узлу с номером 376 силы в направлении оси X 

со значением 2 000 команда F имеет следующий вид: Р, 376,FX,2000 

Имя команды может быть сокращено до первых четырех символов. 

Например, FINISH, FINIS и FINI вызывают одни и те же действия.  
Аргументы команды могут являться числами или алфавитно-

цифровыми метками в зависимости от цели их применения. В примере 
использования команды F, показанном выше, NODE и VALUE являют-
ся числами, а аргумент Lab является алфавитно-цифровой меткой.  

Ряд команд (например, /PREP7, /POST1, FINISH и т. д.) аргумен-
тов не имеют, в результате чего полная команда состоит только из 
названия самой команды. 

Для написания программы в комплексе используются следующие 
правила: 

–  в каждой строке должна быть одна команда;  
 максимальное число знаков в одной строке может достигать 640; 
 при вызове команды ее аргументы должны располагаться в соот-

ветствующих полях. Для пропуска аргументов можно использовать по-
следовательно идущие запятые. В этом случае комплекс ANSYS ис-
пользует для пропущенных значений значения, применяемые по умол-
чанию (как указано в описании отдельных команд); 

 значения действительных чисел должны находиться в пределах 
от ±10

-60
 до ±10

60
. Абсолютное значение целых чисел должно находить-

ся между 0 и 99 999 999; 
 комплекс интерпретирует числа, указанные при помощи аргу-

ментов Angle, как градусы. Следует обратить внимание, что в комплек-
се имеются функции, которые могут использовать радианы при ис-
пользовании команды; 
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 следующие специальные символы не могут применяться в алфа-

витно-цифровых аргументах: «!», «@», «#», «$», «%», «&», «^», «*», 

«( )», «_», «–», «+», «=», «|», «\», «{ }», «[ ]», «“», «‘», «/», «<», «>», «~»;. 

 в комплексе отсутствует типизация переменных, в связи с этим 

не требуется описание типов переменных. Все переменные, организуе-

мые пользователем, воспринимаются как действительные; 

 для задания действительных чисел используется десятичная точ-

ка. Для чисел в экспоненциальной форме можно применять формы за-

писи с E и D. Например, число 25000 может быть записано в форме 

25E3 или 25D3; 

 комментарии в командной строке записываются, используя сим-

вол «!». 

Для минимизации объема исходной информации большинство ко-

манд имеют значения, применяемые по умолчанию. Существует два 

типа значений по умолчанию: действие команды по умолчанию и зна-

чение аргумента, используемое по умолчанию. 

Действие команды по умолчанию – указание действий в случае, ес-

ли команда не вызывалась. Например, если команда /FILNAME не вы-

зывалась, именем файла (jobname) по умолчанию является FILE. 

Значение аргумента, используемое по умолчанию, – значение, при-

нимаемое для неуказанного аргумента команды. Например, если вызы-

вается команда N,10 (создание узла с номером 10 с координатами X, Y 

и Z, в качестве которых стоят пробелы), узел создается в начале систе-

мы координат; в этом случае координаты X, Y и Z по умолчанию равны 

нулю. В описании команд значения аргументов, действующих по умол-

чанию, обычно оговариваются. 

 

3.2 Структура командного файла 
 

Структура простейшего командного файла будет следующей: 
/FILNAME, filename 
/TITLE, titlename 
/UNITS, units 
Блок команд, определяющих переменные, которые используются 

в программе. 
Блок команд, определяющих функции, которые используются в 

программе.  
/PREP7 
Блок команд, отвечающих за построение модели (определение типа 

элемента, определение опций элемента, определение констант элемен-
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та, определение свойств материала, создание конечно-элементной мо-
дели. Приложение нагрузок). 

FINISH 

/SOLU 

Блок команд, отвечающих за решение (определение типа анализа, 

спецификация решения, решение задачи). 

FINISH 

Далее идет постпроцессорная обработка. При этом в зависимости от 

представления результатов пользуемся одним из двух постпроцессоров. 

/POST1 

Блок команд общего постпроцессора. 

FINISH 

/POST26 

Блок команд временного постпроцессора. 

FINISH 

 

3.3 Элементы программирования 
 

Переменные и массивы в APDL. APDL содержит набор встроен-

ных типов данных и операций, определенных над этими типами. Пере-

менные в терминологии APDL называются параметрами. Тип пара-

метра не нужно явно объявлять. Все числовые величины (независимо 

от их логического смысла – целые или вещественные) сохраняются как 

вещественные числа двойной точности.  

Параметру можно дать любое имя (за некоторым исключением), но 

оно должно начинаться с буквы, состоять только из букв, цифр и сим-

вола подчеркивания и содержать не более 8 символов.  

Другие правила и рекомендации по выбору имен параметров со-

стоят в следующем. 

Не следует использовать в качестве имен также обычно используе-

мые программой идентификаторы, как: 

 метки степеней свободы (TEMP, PRES и т. д.); 

 метки, введенные для удобства (ALL, PICK, STAT и т. д.); 

 метки, введенные пользователем при создании модели (напри-

мер, заданные командой ETABLE); 

 метки типов массивов (например, CHAR, ARRAY, TABLE и т. д.). 

Имена от ARG1 до ARG9 и от AR10 до AR29 зарезервированы за 

локальными параметрами, которые используются при создании макро-

сов. Использование этих имен не рекомендуется.  
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Имена параметров не должны совпадать с аббревиатурами, введен-

ными командой *ABBR. Параметры, начинающиеся символом подчер-

кивания, используются графическим интерфейсом пользователя и соб-

ственными макросами комплекса. Не рекомендуется использовать та-

кие имена.  

Простейшим способом задания параметра является применение 

команды «=». Формат команды Имя = Значение, где Имя – присвоенное 

параметру имя, а Значение – числовое или символьное значение пара-

метра. Символьное значение заключается в одинарные кавычки. Между 

этими кавычками может находиться до 8 буквенных символов. Приме-

рами использования команды «=» являются следующие: 

ABC=-24 

QR=2.07E11 

XORY=ABC 

CPARM='CASE1' 

Можно использовать команду *SET. Приведенные ниже примеры 

иллюстрируют ее использование: 

*SET,ABC,-24 

*SET,QR,2.07E11 

*SET,XORY,ABC 

*SET, CPARM,'CASE1' 

Те параметры, значения которых не задаются, считаются «беско-

нечно малыми» и равными 2
–100

. Например, если параметр А задается 

как А=В, а параметр В не задан, то параметру А присваивается «беско-

нечно малое» значение. 

Для назначения параметрам значений, содержащихся в базе дан-

ных комплекса, используется команда *GET. 

Команда *GET (Utility Menu => Parameters => Get Scalar Data) 

отыскивает значение элемента из базы данных (узел, элемент, поверх-

ность, и т. д.) и хранит его как определенный пользователем параметр.  

Параметры: 

par – имя параметра для сохранения результата запроса на чтение 

свойства. Массив должен быть определен заранее; 

entity – указывает тип свойств объекта, которые будут сохранены. 

Можно применять следующие ключевые слова для этого параметра 

(основные): 

 ACTIVE – текущий активный компонент; 

 AREA – параметры и статистика поверхностей; 

 CDSY – параметры и статистика по координатным системам 

проекта; 
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 CE – параметры и статистика по определенным в проекте 

нагрузкам; 

 CP – параметры и статистика для парных элементов; 

 EDCC – параметры и статистика для контактных объектов модели; 

 ELEM – геометрические, физические, механические параметры 

для выбранного элемента; 

 ETYP – номер набора свойств указанного элемента; 

 LINE – параметры и статистика линий; 

 MPLAB – данные элементов с указанной температурой; 

 NODE – параметры и статистика узлов; 

 PART – параметры и статистика частей; 

 SCTN – геометрические параметры секций; 

 SECP – статистика элементов секций; 

 SHEL – параметры и статистика оболочек; 

 TBFT – параметры и статистика для используемых в проекте 

наборов свойств материалов; 

 VOLU – параметры и статистика для объемных примитивов;  

entnum – указывает номер компонента или номер совокупности 

компонентов (совокупность формируется при использовании команд 

выбора ANSYS), о которых нужно получить данные; 

item1 – имя конкретного элемента; 

it1num – число (или метка) для определенного элемента (если 

определен) item1, для некоторых элементов item1 не требуется it1num; 

item2, it2num – вторичный набор описателей элементов (требуется 

только для специфических команд).  

Полный список значений Item1 см. в описании команды *GET. 

После задания параметров (как задаваемых пользователем, так и 

используемых программой ANSYS) можно получить их перечень, ис-

пользуя команду *STATUS. 

Удалить параметры можно: оставляется незаполненным место 

справа от символа команды «=», например, команда QR= удаляет ранее 

введенный параметр QR. Задание нулевого значения не равносильно 

удалению скалярного параметра. 

Если есть необходимость использовать параметры в другом сеансе 

ANSYS, можно записать параметры в файл и затем считать (восстано-

вить) этот файл. Для записи параметров в файл, используется команда 

PARSAV (Utility Menu => Parameters => Save Parameters). 

Считать параметры из файла можно, используя команду PARRES 

(Utility Menu => Parameters => Restore Parameters). 
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Кроме обычных скалярных параметров в комплексе, используются 

параметры-массивы. 

Массивы могут иметь разную размерность (1D, 2D, 3D, 4D, 5D). 

Размерности массивов можно трактовать следующим образом:  

 1D массивы – строковые массивы. А(5) – обращение к пятому 

элементу строки-массива;  

 2D массивы – массивы из строк и столбцов. A(2,5) – обращение к 

пятому элементу второй строки;  

 3D массивы – массивы из плоскостей, строк и столбцов. A(4,1,8) – 

обращение к четвертой плоскости, первой строке, восьмому столбцу;  

 4D массивы – массивы из книг, плоскостей, строк и столбцов. 

A(3,2,1,6) – обращение к третьей книге, второй плоскости, первой стро-

ке, шестому столбцу;  

 5D массивы – массивы из строк, столбцов, страниц, книг и по-

лок. A(1,4,3,2,8) – обращение к первой полке, четвертой книге, третьей 

странице, второй строке, восьмому столбцу.  

ANSYS предусматривает три типа массивов:   

 ARRAY. Этот тип подобен массивам ФОРТРАНА. Как с масси-

вами ФОРТРАНА, индексы для строк, столбцов, и плоскостей – это по-

следовательные целые числа, начинающиеся с единицы. Элементы мас-

сива могут быть или целыми числами, или вещественными.  

 CHAR. Это символьный массив с каждым элементом, состоящим 

из алфавитно-цифрового значения, не превышающего восемь символов. 

Индексы для строк, столбцов, и плоскостей – последовательные целые 

числа, начинающиеся с единицы.  

 TABLE. Это специальный тип числового массива, который поз-

воляет ANSYS вычислять значения между этими элементами массива, 

явно определенными в массиве. Кроме того, можно определить индек-

сы массива для каждой строки, столбца и плоскости. Эти индексы – 

вещественные числа. 

Чтобы задать массив, сначала следует объявить его тип и размер, ис-

пользуя команду *DIM (Utility Menu => Parameters => Array Parameters => 

=> Define/Edit).  

Следующие примеры иллюстрируют применение команды *DIM, 

используемые для определения размерности различных типов массивов:  

*DIM,XYZ,ARRAY,12               ! тип ARRAY, размерность 12[x1x1]  

*DIM,FORCE,TABLE,5              ! тип TABLE, размерность 5[x1x1]  

*DIM,CPARR1,CHAR,5             ! тип CHAR, размерность 5[x1x1] 
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Для задания массивов используется команда «=». Команда «=» 

действует аналогично такой же команде для скалярных параметров за 

исключением того, что теперь задается колонка данных (до десяти ве-

личин на каждый символ «=»).  

Например, чтобы задать параметр XYZ размера 12х1, потребуется 

две команды «=»: 

*XYZ(1)=59.5,42.494,-9.01,-8.98,-8.98,9.01,-30.6,51 

*XYZ(9)=-51.9,14.88,10.8,-10.8 

Команда *VEDIT (Utility Menu => Parameters => Array Parameters => 

=> Define/Edit), доступная только в интерактивном режиме, запускает 

диалоговое окно ввода данных, которое можно использовать, чтобы ре-

дактировать массивы типа ARRAY или TABLE. 

Чтобы прочитать массив из файла, используются команда: 

*VREAD (Utility Menu => Parameters => Array Parameters => Read 

from File). 

Как и со скалярными параметрами, есть возможность применения 

команды *STATUS для получения листинга массивов. 

Чтобы удалить параметр-массив (числовой или символьный), до-

статочно оставить пустой правую сторону команды «=». Так, например, 

команда XYZ(1)= удаляет параметр-массив XYZ. 

Повторение, ветвление и выполнение циклов в APDL. По 

умолчанию команды комплекса выполняются последовательно, незави-

симо от того, вводятся ли они с помощью клавиатуры или из файла. 

Средства повторения, ветвления и выполнения цикла, которыми распо-

лагает язык APDL, позволяют изменить последовательный порядок ис-

полнения команд:  

 повторение предыдущей команды несколько раз;  

 ветвление – выход из блока команд и переход к другому при вы-

полнении определенных условий;  

 выполнение циклов – организация циклического повторения по-

следовательности команд несколько раз.  

Эти средства можно использовать в любом месте программы 

ANSYS, но особенно они полезны в макрокомандах.  

Команда *REPEAT используется для повторного исполнения ко-

манды при изменении значения любого поля этой команды на постоян-

ную величину.  

Например, командами 

 N,1,0,0,0,,,,    

*repeat,10,1,1,1,0  

генерируется 10 узлов (рисунок 10). 
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Рисунок 10 – Результат применения команды *REPEAT 

 
Ветвление можно реализовать с помощью конструкции условного 

перехода if-then-else, используя для этого команды *IF, *ELSE, 
*ELSEIF и *ENDIF. 

Команда *IF имеет следующий синтаксис: 
*IF, VAL1, Oper, VAL2, Base,  
где  
 VAL1 – первое числовое значение (или числовой параметр) для 

сравнения;  
 Oper – оператор сравнения;  
 VAL2 – второе числовое значение (или числовой параметр) для 

сравнения;  
 Base – действие, которое происходит, если условие выполняется.  

APDL предлагает несколько операторов сравнения:   
 EQ – равно (для VAL1 = VAL2);  
 NE – не равно (для VAL1 ≠ VAL2);  
 LT – меньше чем (для VAL1 < VAL2);  
 GT – больше чем (для VAL1 > VAL2);  
 LE – меньше чем или равный (для VAL1 ≤ VAL2); 
 GE – больше чем или равный (для VAL1 ≥ VAL2).  

При присвоении аргументу Base значение THEN, команда *IF ста-
новится началом конструкции «если-тогда-иначе».  

Конструкция состоит из команды *IF, сопровождаемой одной или 
более дополнительными командами *ELSEIF, дополнительной коман-
дой *ELSE и командой *ENDIF, отмечающей конец конструкции.  

Следующий пример демонстрирует более сложную структуру, 

представленную на рисунке 11.  
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Рисунок 11 – Блок-схема 

 

Обратите внимание, что может быть выполнен только один блок. 
Если ни одно из условий не имеет значение «истина», то выполняется 
блок после команды *ELSE. 

Команда *DO,par,ival,fval,inc организует цикл, указывает начало 
тела цикла. 

Параметры: 
par – имя скалярного параметра, который используется как счетчик 

итераций цикла. Нельзя использовать строковые параметры; 
ival – начальное значение счетчика; 
fval – конечное значение счетчика; 
inc – шаг счетчика (по умолчанию единица). 
Для всех параметров допускается использовать отрицательные 

числа. Можно использовать нецелочисленные параметры. 
Если ival > fval, выполнение цикла прекращается (если указанное 

имеет место при первом входе в цикл, тело цикла не выполнится ни разу).  
Команда *DO может быть использована в любом процессоре. 
Команда *ENDDO указывает на завершение тела цикла. Эта ко-

манда парная команде *DO. Все команды, расположенные между   
*DO–*ENDDO, образуют тело цикла. Команда *ENDDO может быть 
использована в любом процессоре.  
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Пример использования блока *DO – *ENDDO с применением ко-

манды *IF:  

C1=1 !начальное значение С1 

C2=3 !начальное значение С3 

!цикл от 1 до 10 с шагом 1, начало тела цикла 

*DO,i,1,3, 

C1=C1+1!увеличить С2 на единицу 

!если С1 > С2 увеличить С2 на единицу 

*IF,C1,GT,C2, THEN 

C2=C2+1!увеличить С2 на 1 

*ENDIF 

*ENDDO !окончание тела цикла 
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